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Introduction to Molecular Modeling using ArgusLab 
ArgusLab is a free molecular modeling package that runs under Windows. It is installed on all public 
computers in Shoker Science Center (an icon should be on your desktop), and you may also download it 
for personal use from www.brothersoft.com/publisher/planaria-software-llc.html. (Of course, you can’t 
install it on a public computer at Bluffton University; you don’t have permission for that!) 

By the end of this tutorial, you will know  

• how to build molecules in ArgusLab an atom at a time;  

• how to build molecules in ArgusLab using template structures;  

• how to change atom and bond types; and  

• how to use previously-saved structures as starting points for building new structures. 

We will build the same models you built in lab, using ArgusLab. 

This worksheet will not be graded. However, you will be given graded ArgusLab exercises in the near 
future. 

Note to users of ArgusLab 4.0.1 and Windows XP: 
ArgusLab may freeze, or even freeze your Windows XP computer, unless you turn off video hardware 
acceleration on your computer. To do this, 

1. Right-click on your Windows desktop and select “Properties”. 

2. Select the “Settings” tab and click the “Advanced” button at the bottom right. A new window will 
open. 

3. Select the “Troubleshoot” tab in the new window. Move the slider labled “Hardware 
acceleration” to “None”. 

4. Click “OK,” and click “OK” to make the “Properties” window go away. 

Shoker Science Center computers have all been “fixed” to keep this from happening. 

A note: you should create a separate directory on your H-drive labeled “ArgusLab” or something similar. 
Save all ArgusLab files to this directory. You want to do this because ArgusLab computations create 
extra files that you may later want to delete, and having them all in a single directory makes this easier. 

 

http://www.brothersoft.com/publisher/planaria-software-llc.html�
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Model #1: but-2-yn-1-ol 
When you open ArgusLab, it will have a new, blank molecule window for you to 
use. If there isn’t, click on the “blue dot” button, upper row, far left. Do not click 
in the window yet. 

You will have two rows of buttons. In the second row, make sure that both 
“pencil” buttons are depressed. The “pencil, dot” button is the “draw new atoms” button, and the “pencil, 
hexagon” button is the Builder tool. If the Builder tool is on, you will have a “builder” next to the 
molecule window. In that window, the “Atoms” tab should be on top; the element selected should be 
carbon (C), and the geometry should be “tetrahedral.” 

Notice that when your cursor is in the molecule window, it will be labeled “C (tetrahedral)”. Right-click 
once in the window and a carbon atom will appear. 

Now go to the builder window. The “Atoms” tab should be on top; click “linear” and notice that your 
cursor will now read “C (linear)”. Right-click again in the window, then do it again. You will have built 
two more carbon atoms. Try to keep them in a more-or-less straight line. 

Click “tetrahedral” under “geometry” again, and right-click a fourth time in the window. You should now 
have four carbon atoms in the window. 

In the Builder window, click oxygen (O). The geometry should still read “tetrahedral.” Right-click again 
in the window, and you will see an oxygen atom appear. Left-click anywhere in the window to deselect 
all atoms. Now click on the “yellow-arrow” button in the second row of buttons; when you mouse over, 
the hint should read “Set mode to ‘selection’ for right mouse button.” This will keep you from 
accidentally putting extra atoms in the window. 

To bond the atoms together, click on the “horizontal red line” button in the second row at the top of the 
window; when you mouse over the button, the hint should read “Automatic bonds are OFF. Click to turn 
ON.” Now left-click on the four atoms in the same order you built them. Left-click anywhere in the 
window to deselect all atoms. 

In the top row, there are three buttons labeled “H”. When you mouse over the left-hand “H” button, the 
hint will read “Add hydrogens.” Click the button. You should see three hydrogens on the first carbon, no 
hydrogens on the second and third carbons, two on the fourth carbon, and one on the oxygen. 

If you do not see the proper number of hydrogen atoms, right-click on the atom(s) with the wrong number 
of hydrogens and mouse over “Change atom.” Select the proper atom type: the first and fourth carbons 
should be “C_3 tetrahedral;” the second and third should be “C_1 linear;” the oxygen should be “O[sp3] → 
O_3 tetrahedral.” Click the “H-eraser” button (“Delete Hydrogens”). Then click on “Add hydrogens” 
again. 

Notice that all the bonds show as single bonds. To fix this, right-click on the bond between the second 
and third carbons. Select “triple.” You are now ready to optimize the structure.  

In the top row, there is a little “wrench” button with the hint “Clean geometry.” Click the button. You will 
be prompted to save your structure; do so. When the calculation is finished, close the molecule window.1

                                                      
1 Because of a glitch in ArgusLab, clicking the “save file” button or choosing “Save” under the File menu does not 
save the structure; instead you must use “Save As…” However, if you exit the window and save when prompted to 
do so, your structure is saved. 

 

OH
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Acetaminophen 
Open a new molecule window, and be sure the Builder is 
open. Click on the “pencil dot” button to allow you to add 
atoms to the window. 

Now click on the “Rings” tab in the builder. Select the 
benzene button (second row, right) and right-click in the 
window. Then left-click in the window to deselect the 
molecule. 

Click on the yellow arrow button, then right-click on one of 
the hydrogen atoms on the ring. Change the atom type to “O[sp3] → O_3 tetrahedral”. Then change the 
hydrogen atom on the opposite side of the ring to “N[sp3] N_3 tetrahedral.” 

If necessary, move the molecule to give you room to add atoms next to the nitrogen (see the Lewis 
structure, above right). Do this by clicking the ╬ “Translate” button (second row, far left) and moving the 
structure with the left mouse button. 

Now click on the “pencil dot” button again. Select carbon in the builder window, and add, next to the 
nitrogen, first a trigonal planar carbon and then a tetrahedral carbon. Now add an oxygen (trigonal planar) 
– in the appropriate place – and connect the loose atoms with the appropriate bonds.1

Click on the “yellow arrow” and change the C-O bond to a C=O bond. Then add hydrogens and clean up 
the structure (“wrench” button). 

  

The cleaned-up structure is not a very good one, so we will use another method, molecular orbital 
calculations, to get a better structure. 

Click on the hexagon button in the top row; when you mouse over it, it will say “Settings for a geometry 
optimization calculation.” In the upper left of the new dialog box, select “AM1” and click “OK” in the 
upper right side of the box. The calculation will be slower, and it may not finish.2

Using the “Rotate” button (second row, second from left), rotate your structure in the window and 
compare it to your Molecular Visions model. Is there anything that is not quite the same? 

 If the calculation has 
not finished, click the Bunsen burner (“Run a calculation”) in the top row, middle. If the calculation still 
does not finish, run the calculation once more. Usually three iterations is enough to get a good structure, 
even if you don’t get a fully optimized geometry. 

                                                      
1 Click the bond button and join atoms: (a) left-click on the atom you want to start at; (b) left-click on the next atom. 
Notice that if one atom is highlighted, left-clicking on another atom will create a bond to that atom, and that atom is 
then highlighted. 
2 If the calculation finishes, the message box in the bottom of the window will read “Geometry optimization 
converged !!” Otherwise, it will say “Maximum cycles reached, optimization terminated.” 
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Proline 
Open a new window. In the Builder, select “Rings” and select 
cyclopentane (top row, right). Right-click and then left-click in the 
window; cyclopentane will be there. 

Activate the yellow arrow button. Change one of the carbon atoms to 
“N[sp3] N_3 tetrahedral”. Then, left-click on one of the hydrogens 
attached to the nitrogen and delete it. 

Save the molecule as “proline-1.” Then save it again as “proline-2.” 

Choose one of the carbon atoms next to nitrogen and change one of its hydrogens to “C[sp2] C_2 
trigonal, non-aromatic.” Add one tetrahedral oxygen and one trigonal planar oxygen, then attach them to 
the new carbon atom. Click “Add hydrogens” and clean the structure.1

Now open your other proline structure. This time, use the other hydrogen on the same carbon atom to 
build the three new atoms. Add hydrogens, clean the structure

 Close the structure and save it. 

1 and save. 

Open both your proline structures at the same time. Under the Window menu, click “Tile.” For each 
structure, under “Label” select “Atom Label Settings” and select “Chiral centers.” Under the “Label” 
menu select “All atoms” for each structure. One structure should now be labeled “R”, the other “S.” 

Manipulate the models to convince yourself that they are, indeed, mirror images.2

  

 

                                                      
1 You may wish to optimize the structure using AM1 calculations. 
2 Of course they will not be precise mirror images, but the chiral center of each should be the mirror image of the 
chiral center of the other. 
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Introduction to chirality using ArgusLab 
ArgusLab is a free molecular modeling package that runs under Windows (and only under Windows). It 
is installed on all public computers in Shoker Science Center (an icon should be on your desktop), and 
you may also download it for personal use from www.arguslab.com/downloads.htm. (Of course, you 
can’t install it on a public computer at Bluffton University; you don’t have permission for that!) 

By the end of this tutorial, you will know how to build molecules in ArgusLab an atom at a time, or using 
template structures; how to change atom and bond types; and how to use previously-saved structures as 
starting points for building new structures. 

Note: 
ArgusLab may freeze, or may even freeze your computer, unless you turn off video hardware 
acceleration on your computer. To do this, 

5. Right-click on your Windows desktop and select “Properties”. 

6. Select the “Settings” tab and click the “Advanced” button at the bottom right. A new window will 
open. 

7. Select the “Troubleshoot” tab in the new window. Move the slider labled “Hardware 
acceleration” to “None”. 

8. Click “OK,” and click “OK” to make the “Properties” window go away. 

In practice, you will probably find that you can have video hardware acceleration turned on at a low level, 
but be aware (if things freeze up for you) that this is what is happening. 

Chirality, chiral molecules and chiral centers 
Any object that is not identical to its own mirror image is chiral. Two easy macroscopic examples are 
your hands: your right hand is the mirror image of your left (unless you’re missing fingers), but your right 
hand is not identical to your left (you can’t easily get it into a left glove, for example). Therefore your 
hands are chiral objects.  

Molecules can be chiral too; we will look at a few examples in this exercise. Within molecules, individual 
atoms can be chiral centers if they have four different substituents; this can include lone pairs, as we 
will see. Molecules with chiral centers have stereoismers that differ only in the arrangement of groups 
around each chiral center. 

We will build the following chiral molecules and examine their stereoisomers:  

• 2-chlorobutane 

• Alpha-methylbenzylamine (that is, 1-phenylethanamine) 

• Tartaric acid, which has two chiral centers. 

A note: you should create a separate directory on your H-drive labeled “ArgusLab” or something similar. 
Save all ArgusLab files to this directory. You want to do this because ArgusLab computations create 
extra files that you may later want to delete, and having them all in a single directory makes this easier. 

 

http://www.arguslab.com/�
http://www.arguslab.com/downloads.htm�
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2-chlorobutane.  
Open ArgusLab and click the “Create New Molecule” button at the upper left.  

ArgusLab defaults to “no bonds drawn,” but that’s not the way we want it. So 
click the button just to the left of the dumbbell-shaped buttons in the second 
row. (On mouseover it should say, “Automatic bonds are OFF. Click to turn 
ON.”) 

Now right-click on the molecule window; an atom will appear (the default is carbon). Move the mouse a 
little and right-click again; another atom will appear, bonded to the first atom. Add two more atoms to the 
chain in this way. 

(If you forgot to turn on automatic bonds, you can get bonds by left-clicking on the first atom to highlight 
it, then left-clicking on the atom you want the bond to go to. Continue to create bonds in this way until all 
bonds have been formed.) 

When you have drawn four atoms, bonded in a straight (or zigzag) line, click the yellow arrow button in 
the second row. This turns off the builder mode. 

Now look for the “H” buttons in the top row. The leftmost “H” will say “Add hydrogens” when you 
mouse over it. Click this button; hydrogens will appear on your molecule.  

Now we will convert our model of butane into 2-chlorobutane. 

Right-click on one of the hydrogen atoms on the second carbon and select “Change atom” and then “Cl 
[s], Cl chlorine.” Now clean the geometry again by clicking the pliers button. 

Before the cleanup is performed, ArgusLab will ask you to save your file. Name it “2-chlorobutane.” You 
have just built your first chiral molecule! But… is it R or S? 

(Click the button just to the left of “Add hydrogens”–it is “Center the molecule in the window”–to ensure 
that everything is on-screen. You will probably want to use this button now and again.) 

To find out, select the “Label” menu and click “Atom label settings.” Select the “Chiral centers” radio 
button at the bottom, then click “OK.” Now, from the Label menu, select “All atoms.” Your chiral center 
will now be labeled either (R) or (S). Convince yourself that the label is correct by using the “steering 
wheel” method. 

Now open a new molecule window. Click “Create new molecule” and under the “Window” menu, select 
“Tile.” In the new window, build the mirror image of your first molecule. Set the labels to show chiral 
centers and turn on labeling in your new molecule. Does it have the opposite (R/S) designator as your first 
molecule? If so, satisfy yourself that the two are indeed mirror images. (Ignore variations in methyl group 
conformations; your chiral centers should be mirror images!) 

Close the two molecule windows, after saving your final structures under new file names. 1

 

 

                                                      
1 You should do this for every ArgusLab structure you generate, because ArgusLab sometimes does not save files 

when you simply tell it to “Save.” 
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Alpha-methylbenzylamine.  
Open a new molecule window.  On the left-hand side of your screen will be 
three tabs; select “Rings” and click on the benzene ring (see the structure of α-
methylbenzylamine and select the ring that looks like that.) Right-click in the 
molecule window to make the ring. 

The ring will be a bit odd-looking, and all atoms will be selected; to make it 
look more normal (and allow us to continue to build), click on the yellow arrow 
button. Now right-click on one of the hydrogen atoms and, under “Convert 
hydrogen to Group,” select “-CH3.” 

Choose one of the hydrogens on the new methyl group and convert it to another methyl group. Now 
convert one of the hydrogens on your CH2 group to “-NH2.” Clean the structure again; save it as “a-
methylbenzylamine.” Now save a copy of the structure by using “Save as…” 

Rather than build the mirror-image from scratch, we will make it from the copy of our first α-
methylbenzylamine model.  

Under the File menu, select “Open” and choose one of your methylbenzylamine models. (If you choose 
the one that is already open, you will get an error message. If you do, just open the other file.) Now select 
“Window”, then “Tile” so you can see them both onscreen. To give yourself more room onscreen, you 
may want to turn off the “pencil benzene” button (“Turn off the build menu”). If you do this, you will 
need to tile your windows again. For each window, select the “four-arrows” button in the top row 
(“Center the molecule in the window”). 

For one of your models, do the following sequence:  

1. Select the “H eraser” button (“Delete hydrogens”).  

2. Right click on the nitrogen atom and delete it. 

3. Select the left-hand “H” button (“Add hydrogens”). 

4. Turn your molecule so that it’s a mirror image of the other (except for the missing nitrogen). 
Then convert a hydrogen into an NH2 group to make it a true mirror image. 

5. Clean the structure and save. 

Using the “steering wheel” method, assign each window “R” or “S”. Now turn on chirality labels in both 
windows. Were you correct?  
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Tartaric acid.  
This molecule has two chiral centers; see whether you can identify them in the 
drawing.  

To build our first tartaric acid model, we begin by building ethane. Turn on 
Automatic bonds, and right-click twice in the window to place two carbon atoms, 
with a bond between them. Now click the yellow-arrow button, then “Add 
hydrogens.” 

Build the carbonyl groups. Right-click an end hydrogen atom, and Convert 
hydrogen to Group “-COO(−).” Do the same with a hydrogen at the other end of the chain. 

Right-click on one of the C-O bonds and change it to “Double”. Change the other C-O bond at that end of 
the structure to “Single.” Do the same for the C-O 
bonds at the other end of the structure. 

Right-click one of the single-bonded oxygens, and 
“Change Atom” to “O [sp3] > O_3, tetrahedral.” Do 
the same for the other single-bonded oxygen atom. 
Click “Add hydrogens” to fill out the valences. If 
you have done everything correctly, you should have 
a structure like the one at left (or you may have one 
in which the COOH groups are next to each other). 

Clean the geometry and save your structure as “butanedioic acid” because that’s what it is. 

There are three isomers of tartaric acid (shown below). Build each isomer from your model of butanedioic 
acid by converting two hydrogens to “-OH” groups; use chiral labeling to confirm that you have made 
what you think you have made. 
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Compare the three isomers in three windows. Two of them are mirror images of each other; one is not. 
Which is the odd structure out? Which structure has a mirror plane such that half of it is the mirror image 
of the other half? 

To hand in: 
Name each of the product structure files, from all three exercises, with the correct chiral designation (for 
example, “R-2-chlorobutane” or “SS-tartaric acid”) and e-mail your structure files to the instructor for 
grading. 

Experimental Techniques 
The following experiments are intended primarily as practice in necessary techniques in the organic 
chemistry laboratory. Most or all of these techniques will be new to you, but they will be used in other 
experiments in this laboratory manual. 
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Pre-laboratory worksheet for Biosynthesis of ethanol 
1. What component of molasses is processed into ethanol by yeast? 

 

 

 

2. Why do we need to allow gas to escape from our fermentation vessel? 

3. Why do we need to prevent air from entering? 

4. Why does a distillation apparatus need an opening in it, somewhere? 

5. I, __________________________________, have read and understood the experimental procedure. I 
am familiar with the hazards and with the required disposal procedures for this experiment. (Sign 
your name) 
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Prelaboratory worksheet for Isolation of caffeine from tea 
1. This procedure is a modification of the standard one, in which tea bags are boiled for twenty minutes. 

What advantages/disadvantages do you think the procedure we will use might have over the other? 

2. You will extract the tea three times with dichloromethane. Why not six, or ten times? Why not just 
once? (HINT: see Zubrick, Chapter 37!) 

3. You will wash the dichloromethane solution with strong base. Explain a possible reason for this. (No, 
dichloromethane is not an acid. If that were so, it would be hazardous to treat it with concentrated 
base! Why? What is the extraction doing for you?)  

4. Consider the chemicals used for this experiment. What realistic hazards are present? What safety 
procedures are necessary beyond wearing glasses and gloves? 

5. I, __________________________________, have read and understood the experimental procedure. I 
am familiar with the hazards and with the required disposal procedures for this experiment. (Sign 
your name) 



71 

Pre-laboratory worksheet for Resolution of a racemic mixture, week 1 
1. Why is it impossible to just distill the (+)-α-methylbenzylamine away from the (-) enantiomer? 

 

2. What does making the tartrate salt do for you? Why can’t you just use acetic acid? 

 

3. Why is dilute acid so effective at destroying the odor of the amine? How does it help in washing the 
amine away? (HINT: what chemical reaction is involved? What does the reaction do for the water 
solubility of the amine? 

 

 

4. Consider the chemicals used for this experiment. What realistic hazards are present? What safety 
procedures are necessary beyond wearing glasses and gloves? 

 

 

 

 

 

 

 

 

5. I, __________________________________, have read and understood the experimental procedure. I 
am familiar with the hazards and with the required disposal procedures for this experiment. (Sign 
your name)  
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Pre-laboratory worksheet for Resolution of a racemic mixture, week 2 
1. What is the purpose of treating the tartrate salt with strong base? (HINT: think about the chemistry 

involved in making the salt. How will the base undo that chemistry?) 

 

2. When you perform the extraction, which layer do you expect to be on the bottom? Why? 

 

3. Why is it reasonable to evaporate dichloromethane under reduced pressure, without losing an 
appreciable quantity of the amine? (HINT: what are the boiling points of dichloromethane and 
α-methylbenzylamine?) 

 

 

4. Consider the chemicals used for this experiment. What realistic hazards are present? What safety 
procedures are necessary beyond wearing glasses and gloves? 

 

 

 

 

 

 

 

 

5. I, __________________________________, have read and understood the experimental procedure. I 
am familiar with the hazards and with the required disposal procedures for this experiment. (Sign 
your name)  
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Acetanilide, Phenacetin and Caffeine: a study using ArgusLab 
In this exercise, you will use ArgusLab to build structures using templates, optimize geometries using 
molecular-orbital methods, and generate electrostatic potential surfaces that describe the distribution of 
electrical charge in a molecule. 

You will use the calculated charge surfaces to interpret the results of the Thin-Layer Chromatography 
experiment. You must discuss your results from this exercise in your lab report. 
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Building acetanilide 
Click “Create new molecule” to bring up a new molecule window. If the 
“pencil-hexagon” button (“Show the Builder Toolkit”) is not selected, select 
it to bring up the Builder toolkit on the left side of your window. 

Select the “Rings” tab in the builder toolkit, and select the benzene ring 
(second row, far right). Right-click on the window to place a copy in the window, and left-click to 
deselect your new structure. 

Click the yellow “Selection mode” arrow, and right-click on one of the hydrogens. Use “Convert 
Hydrogen to Group” to change it to a “urea” group, “NHCONH2.” 

Right-click on the NH2 nitrogen and use “Change Atom” to change it to “C [sp3], C_3 tetrahedral.” 
Right-click on the dotted bonds to change them to single bonds, and then click on the “Add hydrogens” 
button in the top row. Clean your geometry by clicking the “pliers” button. Save your structure as 
“acetanilide.” 

We will now optimize the geometry using a molecular orbital method. MO methods allow us to calculate 
atomic charges, which will let us find centers of negative and positive charge in a structure. 

In the top row, click the “hexagon with a circle” button (“Settings for a geometry optimization 
calculation”). In the dialog that appears, go to the upper left corner and select “AM1.” Select “OK” in the 
upper right corner, and your calculation should start. (It will take a minute or two.) When the calculation 
finishes, you will see a message below your structure. If it does not say “Geometry optimization 
converged !!”, you will need to run the calculation again. 

To restart the calculation, look in the upper row of buttons for one that looks like a Bunsen burner (“Run 
a calculation”). Select it, and your calculation will restart. Repeat the calculation until your geometry 
optimization converges, or (if it does not converge) you have run at least six calculation cycles. Save your 
structure again by closing the structure window and clicking the “Yes” box. 

NH CH3

O
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Building phenacetin 
You may have noticed that “phenacetin” is simply acetanilide 
with an ethoxy group on the opposite end of the ring. We can 
build phenacetin from acetanilide. 

Open your optimized acetanilide structure, and save it as 
“phenacetin.” Now change the appropriate hydrogen (opposite the nitrogen atom) to an OH group. 
Convert the OH hydrogen to a methyl group, then change one of the methyl hydrogens to another methyl 
group so that you have an ethyl group attached to oxygen. You should now have the structure shown 
above right. Clean the geometry. 

Set up and run an AM1 geometry optimization calculation, and repeat it until the geometry optimization 
converges, or until you have run at least six calculation cycles. (This will take longer than acetanilide 
because there are more atoms.) Save your structure by closing the structure window and clicking “Yes.” 

 

Building caffeine 
Building this structure will be more involved than for acetanilide or 
phenacetin, because there is no template in ArgusLab for a purine. 

Instead, we will use the “indole” template (bottom row, center of the 
“Rings” tab; see the structure of indole, above right). Add a model of indole 
to your window. Now refer to the structure of caffeine, below right. 

In the five-membered ring, change the appropriate carbon atom to “N [sp2] 
> N_R, aromatic” and delete the hydrogen atom. Then change the hydrogen 
atom on the other nitrogen to a methyl group. 

In the six-membered ring, change the appropriate two carbon atoms to “N 
[sp2] > N_R, aromatic” and change their hydrogen atoms to methyl groups. 

Change the hydrogen atoms on the two appropriate carbon atoms to “O 
[sp2] > O_2, non-aromatic” and change the bonds to these oxygens from 
single to double by right-clicking on the bonds. 

Right click on each ring bond and change it to single or double as 
appropriate. Clean the geometry. Save the structure as “caffeine.” 

Set up and run an AM1 geometry optimization calculation, and repeat it until the geometry optimization 
converges or you have run at least six calculation cycles. (This will take longer than acetanilide because 
there are more atoms.) Save your structure again by closing its window and clicking “Yes.” 
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Electrostatic potential surfaces 
To interpret your TLC results, you need to identify points on each of the three known compounds that can 
act as hydrogen-bond acceptors, that is, as strong Lewis bases. They will therefore be centers of negative 
charge in the molecule. 

You can identify such points by generating the electrostatic potential surface for a molecule. 

In ArgusLab 4.1.0, this is extremely simple. Once a molecule’s geometry is optimized, click the “Easter 
egg” button in the second row of buttons (“Quick-plot ESP-mapped density surface”). 

Centers of negative charge are indicated in red. If you right-click on the surface and click “modify 
surface,” you can make it translucent so that you can see atoms underneath. It will be easier to compare 
the three compounds if you put them in tiled windows. 

Remember that compounds that are better hydrogen bond acceptors (that is, that have more negatively-
charged sites) will adhere more strongly to silica gel. Order the three compounds in the order you expect 
them to move on silica gel, based on their calculated electrostatic potential surfaces. Is this trend 
supported by your results? 
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Prelaboratory worksheet for Thin Layer Chromatography 

1. Explain why you need to allow a TLC plate to dry completely after spotting, before either double-
spotting or developing the plate. 

 

 

2. Explain why you mark the TLC plate in pencil rather than in pen. (Zubrick should have something 
about this.) 

 

3. Which type of fire extinguisher would you need to put out the most likely type of fire in this 
experiment? (Choose from water, CO2, ABC dry chemical, or Type D. More than one correct answer 
may exist.) Justify your answer. 

 

 

4. Consider the chemicals used for this experiment. What realistic hazards are present? What safety 
procedures are necessary beyond wearing glasses and gloves? 

 

 

 

 

 

 

 

5. I, __________________________________, have read and understood the experimental procedure. I 
am familiar with the hazards and with the required disposal procedures for this experiment. (Sign 
your name) 
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Prelaboratory worksheet for Analysis of fatty acid composition of lipids 

1. What is the function of the boron trifluoride in this experiment? 

 

2. Why do we see a different retention time on the GC for fatty acids with different numbers of carbons? 
For fatty acids with the same number of carbons but different degrees of unsaturation? 

 

 

 

3. In step 3 of the procedure, you are told to transfer the organic layer to a test tube. Which layer do you 
expect to be the organic layer: the top or the bottom? Why? 

 

 

 

4. Consider the chemicals used for this experiment. What realistic hazards are present? What safety 
procedures are necessary beyond wearing glasses and gloves? 

 

 

 

 

 

5. I, __________________________________, have read and understood the experimental procedure. I 
am familiar with the hazards and with the required disposal procedures for this experiment. (Sign 
your name) 
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Prelaboratory worksheet for Dehydration of an alcohol 
1. Why do we distill the alkene away from the reaction mixture, rather than just allowing the reaction to 

run at room temperature? 

2. Describe how you will be able to determine, by adding bromine (Br2), whether your product is an 
alkene. 

3. What is the purpose of each of the following reagents: phosphoric acid? sodium carbonate? 

4. Consider the chemicals used for this experiment. What realistic hazards are present? What safety 
procedures are necessary beyond wearing glasses and gloves? 

5. I, __________________________________, have read and understood the experimental procedure. I 
am familiar with the hazards and with the required disposal procedures for this experiment. (Sign 
your name) 
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Prelaboratory worksheet for Reduction of a ketone 

1. What is the purpose of the methanol? Why don’t we just use water? (HINT: look up camphor in the 
Merck Index, and see what it says about water vs. alcohol.) 

 

2. Why is sodium borohydride relatively stable in the presence of base, but not in the presence of acid? 
Explain the chemistry involved. 

 

 

3. Why do we expect borneol and isoborneol to be separable by GC? What about R-camphor vs. S-
camphor? 

 

 

4. Consider the chemicals used for this experiment. What realistic hazards are present? What safety 
procedures are necessary beyond wearing glasses and gloves? 

 

 

 

 

 

 

5. I, __________________________________, have read and understood the experimental procedure. I 
am familiar with the hazards and with the required disposal procedures for this experiment. (Sign 
your name) 
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Pre-laboratory worksheet for Saponification 
1. Most oils and fats contain palmitic and stearic acid as building blocks. Give the structures for both 

these compounds. 

2. Describe the role of sodium hydroxide in the reactions we will use. 

3. Look up “saponification” in the unabridged dictionary. What is the source of this word? Is it justified 
to call making biodiesel “saponification”? Why or why not? 

4. Consider the chemicals used for this experiment. What realistic hazards are present? What safety 
procedures are necessary beyond wearing glasses and gloves? 

5. I, __________________________________, have read and understood the experimental procedure. I 
am familiar with the hazards and with the required disposal procedures for this experiment. (Sign 
your name) 
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Pre-laboratory worksheet for week 1: Esterification 
1. What is the function of the sulfuric acid? 

 

2. What hazards are associated with ether? Could you substitute another solvent for the ether during the 
extraction? Suggest a possible substitution. 

 

 

 

3. How will you confirm the identity of your product? 

 

 

 

4. Consider the chemicals used for this experiment. What realistic hazards are present? What safety 
procedures are necessary beyond wearing glasses and gloves? 

 

 

 

 

 

 

 

5. I, __________________________________, have read and understood the experimental procedure. I 
am familiar with the hazards and with the required disposal procedures for this experiment. (Sign 
your name) 
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Pre-laboratory worksheet for week 2: Grignard reaction 
1. What is the most important hazard associated with this experiment? How can you minimize it? 

 

2. How much methyl benzoate did you obtain last 
week? (Do not enter more than 3 grams.) This is the 
amount you will use this week. 

_________ grams methyl benzoate 

How many moles of methyl benzoate are in that 
many grams? _________ moles methyl benzoate 

What is the volume of methyl benzoate you will 
use?  _________ mL methyl benzoate 

How many moles of Grignard will you need to 
react with your methyl benzoate? (Consider 
reaction stoichiometry!) Add 5% to this number 
and enter it in the blank; this is the number of 
moles of Grignard you will be making. 

_________ moles Grignard 

How many grams of magnesium will you need 
to make that many moles of Grignard?  _________ grams magnesium 

How many grams of bromobenzene will you 
need? Add 2% to this number and enter it in the 
blank; this is the number of grams of 
bromobenzene you will use. 

_________ grams bromobenzene 

How many milliliters of bromobenzene are there 
in that many grams? _________ mL bromobenzene 

3. How will you confirm the identity of your final (triphenylmethanol) product? 

 

4. Consider the chemicals used for this experiment. What realistic hazards are present? What safety 
procedures are necessary beyond wearing glasses and gloves? 

 

 

 

5. I, __________________________________, have read and understood the experimental procedure. I 
am familiar with the hazards and with the required disposal procedures for this experiment. (Sign 
your name)  
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